Abstract


The Verizon Business IP Trunk service offer referenced within these Application Notes is designed for business customers. The service enables local and long distance PSTN calling via standards-based SIP trunks directly, without the need for additional TDM enterprise gateways or TDM cards and the associated maintenance costs.

IP Office Release 8.1 with Avaya Session Border Controller for Enterprise Release 6.2 has not been independently certified by Verizon labs. These Application Notes can be used to facilitate customer engagements via the Verizon field trial process, pending Verizon labs independent certification.

Information in these Application Notes has been obtained through DevConnect compliance testing and additional technical discussions. Testing was conducted via the DevConnect Program at the Avaya Solution and Interoperability Test Lab, utilizing a Verizon Business Private IP (PIP) circuit connection to the production Verizon Business IP Trunking service.
Table of Contents

Table of Contents .......................................................................................................................... 2
1. Introduction ............................................................................................................................... 4
2. General Test Approach and Results ......................................................................................... 4
   2.1. Interoperability Compliance Testing .................................................................................. 5
   2.2. Known Limitations ............................................................................................................. 6
   2.3. Support ............................................................................................................................... 7
       2.3.1. Avaya ....................................................................................................................... 7
       2.3.2. Verizon ................................................................................................................... 7
3. Reference Configuration ........................................................................................................... 8
4. Equipment and Software Validated ........................................................................................... 9
5. Avaya IP Office Configuration ................................................................................................10
   5.1. Physical, Network, and Security Configuration ................................................................. 10
   5.2. Licensing .......................................................................................................................... 12
   5.3. System Settings ................................................................................................................... 13
       5.3.1. System Tab .............................................................................................................. 13
       5.3.2. LAN Settings ......................................................................................................... 15
       5.3.3. Voicemail ............................................................................................................... 18
       5.3.4. System Telephony Configuration ........................................................................... 19
       5.3.5. System Twinning Configuration .............................................................................. 19
       5.3.6. System Codecs Configuration ............................................................................... 20
   5.4. SIP Line .............................................................................................................................. 20
       5.4.1. SIP Line – SIP Line Tab .......................................................................................... 21
       5.4.2. SIP Line - Transport Tab ........................................................................................ 22
       5.4.3. SIP Line - SIP URI Tab ......................................................................................... 23
       5.4.4. SIP Line - VoIP Tab ............................................................................................... 24
       5.4.5. T38 Fax ................................................................................................................... 25
   5.5. Users, Extensions, and Hunt Groups .................................................................................. 26
       5.5.1. Digital User 232 ...................................................................................................... 26
       5.5.2. SIP Telephone User (Avaya 1140E) ....................................................................... 29
       5.5.3. Hunt Groups ........................................................................................................... 33
   5.6. Short Codes ........................................................................................................................ 35
   5.7. Incoming Call Routes ......................................................................................................... 37
   5.8. ARS and Alternate Routing .............................................................................................. 39
   5.9. Privacy / Anonymous Calls .............................................................................................. 41
   5.10. Saving Configuration Changes to IP Office ..................................................................... 42
6. Configure Avaya Session Border Controller for Enterprise .................................................. 44
   6.1. Network Management ....................................................................................................... 46
   6.2. Routing Profile .................................................................................................................. 47
   6.3. Server Interworking Profile .............................................................................................. 49
       6.3.1. Server Interworking Profile – IP Office .................................................................. 49
       6.3.2. Server Interworking Profile – Verizon .................................................................. 50
   6.4. Server Configuration ......................................................................................................... 53
       6.4.1. Server Configuration – IP Office ............................................................................. 53
1. Introduction


Customers using Avaya IP Office and Avaya Session Border Controller for Enterprise with the Verizon Business IP Trunk SIP Trunk service are able to place and receive PSTN calls via the SIP protocol. The converged network solution is an alternative to traditional PSTN trunks such as ISDN-PRI. With the market growth of SIP trunk deployments in the SME segment, importing and using SIP trunk templates to reduce installation time and errors associated with programming, will become increasingly valuable to installers working with R8.1. See Appendix A for the Template used in this configuration.

**IP Office Release 8.1 with Avaya Session Border Controller for Enterprise Release 6.2 has not been independently certified by Verizon labs. These Application Notes can be used to facilitate customer engagements via the Verizon field trial process, pending Verizon labs independent certification.**

In the sample configuration, An Avaya Session Border Controller for Enterprise (SBCE) is used as an edge device between the Avaya IP Office and Verizon business. The Avaya SBCE performs SIP header manipulation and provides topology hiding, as well as a variety of other functions providing security and the presentation of a standardized SIP interface.

Verizon Business IP Trunk service offer can be delivered to the customer premises via either a Private IP (PIP) or Internet Dedicated Access (IDA) IP network terminations. Although the configuration documented in these Application Notes used Verizon’s IP Trunk service terminated via a PIP network connection, the solution validated in this document applies equally to IP Trunk services delivered via IDA service terminations.


2. General Test Approach and Results

The Avaya IP Office location was connected to the Verizon Business IP Trunk Service, as depicted in Figure 1. The Avaya SBCE and IP Office were configured to use the commercially available SIP Trunking solution provided by the Verizon Business IP Trunk SIP Trunk Service. This allowed Avaya IP Office users to make calls to the PSTN and receive calls from the PSTN via the Verizon Business IP Trunk SIP Trunk Service.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent
to the interoperability of the tested products and their functionalities. DevConnect Compliance Testing is not intended to substitute full product performance or feature testing performed by DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or completeness of a DevConnect member’s solution.

Testing was successful. Any limitations related to the overall configuration are noted in Section 2.2.

2.1. Interoperability Compliance Testing
The verification testing included the following successful SIP trunk interoperability compliance testing:

- Incoming calls from the PSTN were routed to the DID numbers assigned by Verizon Business to the Avaya IP Office location. These incoming PSTN calls arrived via the SIP Line and were answered by Avaya SIP telephones, Avaya H.323 telephones, Avaya digital telephones, analog telephones, analog fax machines, Avaya IP Office Softphone, and Avaya Voicemail Pro. The display of caller ID on display-equipped Avaya IP Office telephones was verified.
- Incoming calls answered by members of circular Hunt Groups were verified.
- Outgoing calls from the Avaya IP Office location to the PSTN were routed via the SIP Line to Verizon Business. These outgoing PSTN calls were originated from Avaya SIP phones, Avaya H.323 telephones, Avaya digital telephones, analog endpoints, Avaya IP Office Softphone and Avaya Voicemail Pro. The display of caller ID on display-equipped PSTN telephones was verified.
- Inbound / Outbound fax using G.711 and T38 were verified.
- Proper disconnect when the caller abandoned a call before answer for both inbound and outbound calls.
- Proper disconnect when the IP Office party or the PSTN party terminated an active call.
- Proper busy tone heard when an IP Office user called a busy PSTN user, or a PSTN user called a busy IP Office user (i.e., if no redirection was configured for user busy conditions).
- Various outbound PSTN call types were tested including long distance, international, toll-free, operator assisted, and directory assistance calls.
- Requests for privacy (i.e., caller anonymity) for IP Office outbound calls to the PSTN were verified. That is, when privacy is requested by IP Office, outbound PSTN calls were successfully completed while withholding the caller ID from the displays of display-equipped PSTN telephones.
- Privacy requests for inbound calls from the PSTN to IP Office users were verified. That is, when privacy is requested by a PSTN caller, the inbound PSTN call was successfully completed to an IP Office user while presenting an “anonymous” display to the IP Office user.
- SIP OPTIONS monitoring of the health of the SIP trunk was verified. Both Verizon Business and Avaya SBCE were able to monitor health using SIP OPTIONS.
- IP Office outbound calls were placed with simple short codes as well as using ARS. Using ARS, the ability of IP Office to route-advance to an alternate route was exercised.
when the primary SIP line was not responding. The Line Group associated with the Verizon Business SIP Line was the primary line group chosen for a call, or an alternate line group selected upon failure of a primary line.

- Incoming and outgoing calls using the G.729A and G.711MU codecs.
- DTMF transmission (RFC 2833) with successful voice mail navigation using G.729A and G.711MU for incoming and outgoing calls. Successful navigation of a simple auto-attendant application configured on Avaya Voicemail Pro.
- Inbound and outbound long holding time call stability.
- Telephony features such as call waiting, hold, transfer, and conference.
- Inbound calls from Verizon IP Trunk Service that were call forwarded back to PSTN destinations, presenting true calling party information to the PSTN phone, via Verizon IP Trunk Service.
- Mobile twinning to a mobile phone, presenting true calling party information to the mobile phone. Outbound mobile call control was also verified successfully (e.g., using DTMF on a twinned call to place new calls and create a conference via a mobile phone).
- DiffServ markings in accordance with network requirements for Avaya SBCE SIP signaling and RTP media.
- Mobility Features such as Mobile Callback and Mobile Call Control.

### 2.2. Known Limitations

Interoperability testing of the sample configuration was completed with successful results, with the successful verifications detailed in Section 7. The following observations were noted:

1. **FAX:** A SIP Line on IP Office Release 8.1 can be configured to support T.38 fax or fax over G.711. T38 is a new offer from Verizon Business IP Trunk service and requires that the **Disable T30 ECM** be checked on the [SIP Line ➔ T38 Fax](#) page as indicated in Section 5.4.5. Also, Verizon Business IP Trunk service will not perform the expected re-invite to T38 on an outbound fax, but instead will wait and expect IP Office to issue the re-invite to T38. Once the re-invite is issued, Verizon will send a 200 OK to acknowledge the T38. This will be transparent to the user.

2. **HOLD:** When a call is put on hold by an IP Office user, there is no indication sent via SIP messaging to Verizon. This is transparent to the users on the call.

3. **CODEC MISMATCH:** If there is not a matching codec configured on the [SIP Line ➔ VoIP](#) tab to match the service provider, on placing a call the user will briefly hear ring back and then the phone will display “Number Busy”.

4. **SIP PHONE TRANSFER:** When an outbound call to the PSTN via Verizon is transferred from a SIP device registered to IP Office (e.g., Avaya 1140E, Avaya 1220, or IP Softphone in the sample configuration), and the REFER transfer option is enabled on the SIP Line to Verizon, the transferor may briefly see the display “Transfer failed” after the final user operation, even if the transfer has actually succeeded. On the production circuit used for testing, Verizon did not send NOTIFY messages to IP Office to signal
transfer completion. This anomaly is under investigation by Verizon and the IP Office product team as CQ MRDB00116583.

5. **One-X® Portal for IP Office:** When an outbound call to a PSTN phone is blind transferred to another PSTN phone using the One-X Portal client, the From header in the INVITE contains the wrong caller ID and Verizon responds with “408 Request Timeout” causing the transfer to fail. A recommended workaround is to perform a consultative transfer. This observation is under investigation by IP Office product team as IPOFFICE-31275.

### 2.3. Support

2.3.1. **Avaya**

For technical support on the Avaya products described in these Application Notes visit [http://support.avaya.com](http://support.avaya.com).

2.3.2. **Verizon**

3. Reference Configuration

**Figure 1** illustrates an example Avaya IP Office solution with Avaya SBCE connected to the Verizon Business IP Trunk SIP Trunk service. The Avaya equipment is located on a private IP subnet. An enterprise edge router provides access to the Verizon Business IP Trunk service network via a Verizon Business T1 circuit. This circuit is provisioned for the Verizon Business Private IP (PIP) service.

In the sample configuration, the Avaya SBCE receives traffic from the Verizon Business IP Trunk service on port 5060. The Avaya SBCE uses DNS SRV, using UDP for transport, to determine the IP Address and port to be used to send SIP signaling to Verizon. In the sample configuration, the DNS process will result in SIP signaling being sent to IP Address 172.30.209.21 and port 5071. As shown in **Table 1**, the Verizon Business IP Trunk service provided Direct Inward Dial (DID) numbers. These DID numbers were mapped to IP Office destinations via Incoming Call Routes in the IP Office configuration.


**Figure 1: Avaya Interoperability Test Lab Configuration**
Table 1 shows the mapping of Verizon-provided DID numbers to IP Office users, groups, or functions. The associated IP Office configuration is shown in Section 5.

<table>
<thead>
<tr>
<th>Verizon Provided DID</th>
<th>Avaya IP Office Destination</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>732-945-0231</td>
<td>X 231</td>
<td>T7316E Digital Telephone</td>
</tr>
<tr>
<td>732-945-0232</td>
<td>X 232</td>
<td>9508 Digital Telephone</td>
</tr>
<tr>
<td>732-945-0234</td>
<td>X 234</td>
<td>Avaya IP Office Softphone &amp; Flare Experience</td>
</tr>
<tr>
<td>732-945-0235</td>
<td>X 235</td>
<td>Avaya SIP 1140E</td>
</tr>
<tr>
<td>732-945-0237</td>
<td>X237</td>
<td>Avaya H.323 - 9621G</td>
</tr>
<tr>
<td>732-945-0239</td>
<td>Voicemail</td>
<td></td>
</tr>
<tr>
<td>732-945-0240</td>
<td>Short Code: FNE31</td>
<td>FNE Service 31 (Mobile Call Control)</td>
</tr>
<tr>
<td>732-945-0241</td>
<td>X241</td>
<td>Analog telephone or Fax machine</td>
</tr>
<tr>
<td>732-945-0242</td>
<td>X401 Hunt Group</td>
<td>Rotary Ring Mode to all Users</td>
</tr>
</tbody>
</table>

Table 1: Verizon DID to IP Office Mappings

4. Equipment and Software Validated

Table 2 shows the equipment and software used in the sample configuration.

<table>
<thead>
<tr>
<th>Equipment</th>
<th>Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avaya Session Border Controller for Enterprise</td>
<td>Release 6.2 (Q33)</td>
</tr>
<tr>
<td>Avaya IP Office 500 v2</td>
<td>Release 8.1 (65)</td>
</tr>
<tr>
<td>Avaya IP Office Manager</td>
<td>Release 10.1 (65)</td>
</tr>
<tr>
<td>Avaya Application Server</td>
<td>8.1.20-3</td>
</tr>
<tr>
<td>Avaya 2500 Analog Telephone</td>
<td>N/A</td>
</tr>
<tr>
<td>Avaya 9508 Digital Telephone</td>
<td>N/A</td>
</tr>
<tr>
<td>Avaya T7315E Digital Telephone</td>
<td>N/A</td>
</tr>
<tr>
<td>Avaya 1616 IP Telephone (H.323)</td>
<td>Release 1.302B</td>
</tr>
<tr>
<td>Avaya 9611 IP Telephone (H.323)</td>
<td>Release 6.2209</td>
</tr>
<tr>
<td>Avaya 1140E SIP</td>
<td>04.03.12</td>
</tr>
<tr>
<td>Avaya IP Office Softphone</td>
<td>Release 3.2.3.20 64770</td>
</tr>
<tr>
<td>Avaya Flare Experience</td>
<td>1.1.0.5</td>
</tr>
</tbody>
</table>

Table 2: Equipment and Software Tested
5. Avaya IP Office Configuration

IP Office is configured via the IP Office Manager program. For more information on IP Office Manager, consult reference [2]. From the IP Office Manager PC, select Start ➔ Programs ➔ IP Office ➔ Manager to launch the Manager application. Provided that the IP Office system is accessible to IP Office Manager, the following will be displayed in the center of the opening screen:

![Configuration Service User Login](image)

Log in with the appropriate configuration credentials. The appearance of the IP Office Manager can be customized using the View menu. In the screens presented in this section, the View menu was configured to show the Navigation pane on the left side, the Group pane in the center, and the Details pane on the right side.

5.1. Physical, Network, and Security Configuration

This section describes attributes of the sample configuration, but is not meant to be prescriptive. Consult reference [1] for more information on the topics in this section.

In the sample configuration, looking at the IP Office 500 from left to right, the first module is a TCM 8 Digital Station Module. This module supports BCM / Norstar T-Series and M-Series telephones. The second module is a COMBO6210/ATM4 module. This module is used to add a combination of ports to an IP500 V2 control unit and is not supported by IP500 control units. The module supports 10 voice compression channels. Codec support is G.711, G729A and G.723 with 64ms echo cancellation. G.722 is supported by IP Office Release 8.0 and higher. The “Combo” card will support 6 Digital Station ports for digital stations in slots 1-6 (except 3800, 4100, 4400, 7400, M and T-Series), 2 Analog Extension ports in slots 7-8, and 4 Analog Trunk ports in slots 9-12. Referring to Figure 1, the Avaya T7315E telephone with extension 231 is connected to port 1 of the TCM8 module, and the Avaya 9508 telephone with extension 232 is connected to port 1 of the “Combo” card. The analog extension or fax machine is connected to the “Combo” card on port 7.

The following screen shows the modules in the IP Office used in the sample configuration. To access such a screen, select Control Unit in the Navigation pane. The modules appear in the Group pane. In the screen below, IP 500 V2 is selected in the Group pane, revealing additional information about the IP 500 V2 in the Details pane.
In the sample configuration, the IP Office LAN1 port is physically connected to the local area network switch at the IP Office customer site. The default gateway for this network is 10.80.150.1. The Avaya SBCE resides on a different subnet and requires an IP Route to allow SIP traffic between the two devices. To add an IP Route in IP Office, right-click **IP Route** from the Navigation pane, and select **New**. To view or edit an existing route, select **IP Route** from the Navigation pane, and select the appropriate route from the Group pane. The following screen shows the Details pane with the relevant route using **Destination** LAN1.

To facilitate use of Avaya IP Office Softphone, https was enabled in the sample configuration. To check whether https is enabled, navigate to **File** ➔ **Advanced** ➔ **Security Settings**. A screen such as the following is presented. Log in with the appropriate security credentials.
After logging in, select **Services** from the Navigation pane and **HTTP** from the Group pane. In the Details pane, verify the **Service Security Level** is configured as intended, as shown below.

![Security Settings Table]

When complete, select **File → Configuration** to return to configuration activities.

### 5.2. Licensing

The configuration and features described in these Application Notes require the IP Office system to be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity, contact an authorized Avaya sales representative.

To verify that there is a SIP Trunk Channels License with sufficient capacity, click **License** in the Navigation pane and **SIP Trunk Channels** in the Group pane. Confirm a valid license with sufficient “Instances” (trunk channels) in the Details pane.

![License Table]

![SIP Trunk Channels Table]
If Avaya IP Telephones will be used, verify the Avaya IP endpoints license. Click License in the Navigation pane and Avaya IP endpoints in the Group pane. Confirm a valid license with sufficient “Instances” in the Details pane.

The following screen shows the availability of a valid license for Power User features. In the sample configuration, the user with extension 234 will be configured as a “Power User” and will be capable of using the Avaya IP Office Softphone.

5.3. System Settings
This section illustrates the configuration of system settings. Select System in the Navigation pane to configure these settings. The subsection order corresponds to a left to right navigation of the tabs in the Details pane for System settings.

5.3.1. System Tab
With the proper system name selected in the Group pane, select the System tab in the Details pane. The following screen shows a portion of the System tab. The Name field can be used for a descriptive name of the system. In this case, Verizon is used as the name. The Avaya HTTP Clients Only and Enable SoftPhone HTTP Provisioning boxes are checked to facilitate Avaya IP Office Softphone usage.
<table>
<thead>
<tr>
<th>IP Offices</th>
<th>System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operator C1</td>
<td>Verizon</td>
</tr>
<tr>
<td>System (1)</td>
<td></td>
</tr>
<tr>
<td>Line (5)</td>
<td></td>
</tr>
<tr>
<td>Control Unit (3)</td>
<td></td>
</tr>
<tr>
<td>Extension (22)</td>
<td></td>
</tr>
<tr>
<td>User (24)</td>
<td></td>
</tr>
<tr>
<td>User Group (3)</td>
<td></td>
</tr>
<tr>
<td>Short Code (70)</td>
<td></td>
</tr>
<tr>
<td>Service (0)</td>
<td></td>
</tr>
<tr>
<td>IVR (1)</td>
<td></td>
</tr>
<tr>
<td>Incoming Call Route</td>
<td></td>
</tr>
<tr>
<td>Wx/Port (0)</td>
<td></td>
</tr>
<tr>
<td>Directory (0)</td>
<td></td>
</tr>
<tr>
<td>Time Profile (0)</td>
<td></td>
</tr>
<tr>
<td>Free Call (1)</td>
<td></td>
</tr>
<tr>
<td>IP Route (5)</td>
<td></td>
</tr>
<tr>
<td>Account Code (0)</td>
<td></td>
</tr>
<tr>
<td>License (22)</td>
<td></td>
</tr>
<tr>
<td>Tunnel (0)</td>
<td></td>
</tr>
<tr>
<td>User Rights (0)</td>
<td></td>
</tr>
<tr>
<td>WAP (0)</td>
<td></td>
</tr>
<tr>
<td>911 System (1)</td>
<td></td>
</tr>
</tbody>
</table>

**Verizon**

![Verizon System Configuration](image)

- **Name**: Verizon
- **Contact Information**: [Set contact information to place System under special control]
- **Device ID**: [Field]
- **TFTP Server IP Address**: 10.80.150.70
- **HTTP Server IP Address**: 10.80.150.70
- **Phone File Server Type**: Memory Card
- **Manager PC IP Address**: 10.80.150.38
- **Avaya HTTP Clients Only**: [Check box]
- **Enable Selfphone HTTP Provisioning**: [Check box]
- **Automatic Backup**: [Check box]
5.3.2. LAN Settings

The IP500/IP500 V2 control units have 2 RJ45 Ethernet ports, physically marked as LAN and WAN. Within the system configuration, the physical LAN port is LAN1, the physical WAN port is LAN2.

In the sample configuration, LAN1 was used to connect the IP Office to the enterprise network. To view or configure the IP Address of LAN1, select the LAN1 tab followed by the LAN Settings tab. As shown in Figure 1, the IP Address of the IP Office is 10.80.150.70. Other parameters on this screen may be set according to customer requirements. In the example screen, the DHCP Mode was set to “Server” to allow IP Office to facilitate provisioning for the IP Telephones in the sample configuration.

![LAN Settings Screen](image)

Select the VoIP tab as shown in the following screen. The H323 Gatekeeper Enable box is checked to allow the use of Avaya IP Telephones using the H.323 protocol, such as the Avaya 1600-Series and 9600-Series Telephones used in the sample configuration. The SIP Registrar Enable box is checked to allow Avaya 1140E, Avaya Flare Experience, and Avaya IP Office Softphone usage. The SIP Trunks Enable box must be checked to enable the configuration of SIP trunks to Verizon Business.

**RTP Port Number:** For each VoIP call, a receive port for incoming Real Time Protocol (RTP) traffic is selected from a defined range of possible ports, using the even numbers in that range. The Real Time Control Protocol (RTCP) traffic for the same call uses the RTP port number plus 1 (i.e., the odd numbers). For control units and Avaya H.323 IP phones, the default port range used is 49152 to 53246. On some installations, it may be a requirement to change or restrict the port range used. It is recommended that only port numbers between 49152 and 65535 are used, that being the range defined by the Internet Assigned Numbers Authority (IANA) for dynamic
usage. **Port Range (minimum):** Default = 49152. Range = 1024 to 64510. This sets the lower limit for the RTP port numbers used by the system. **Port Range (maximum):** Default = 53246. Range = 2048 to 65534. This sets the upper limit for the RTP port numbers used by the system. The gap between the minimum and the maximum must be at least 1024.

If desired, IP Office can be configured to mark the Differentiated Services Code Point (DSCP) in the IP Header with specific values to support Quality of Service policies. In the sample configuration shown below, IP Office will mark SIP signaling with a value associated with “Assured Forwarding” using DSCP decimal 34 (**SIG DSCP** parameter). IP Office will mark the RTP media with a value associated with “Expedited Forwarding” using DSCP decimal 46 (**DSCP** parameter). This screen enables flexibility in IP Office DiffServ markings (RFC 2474) to allow alignment with network routing policies, which are outside the scope of these Application Notes. Other parameters on this screen may be set according to customer requirements.
Select the **Network Topology** tab as shown in the following screen. In the sample configuration, the default settings were used and the **Use Network Topology Info** in the **SIP Line** was set to “None” in Section 5.4.2. The **Binding Refresh Time (seconds)** can still be used to lower the SIP OPTIONS timing from the default of 300 seconds. During the testing, the Binding Refresh Time was varied (e.g., 30 seconds, 90 seconds to test SIP OPTIONS timing).

If using IP Office as a DHCP server and DHCP Server mode has been selected from the **LAN1 → Lan Settings** Tab, click the **DHCP Pools** tab. Although beyond the intended scope of these Application Notes, the following screen is shown as a simple example.

Optionally, select the **SIP Registrar** tab. The following screen shows the settings used in the sample configuration. The **Domain Name** has been set to the customer premises equipment domain “avayalab.com”. If the **Domain Name** is left at the default blank setting, SIP registrations may use the IP Office LAN 1 IP Address. All other parameters shown are default values.
5.3.3. Voicemail

To view or change voicemail settings, select the **Voicemail** tab as shown in the following screen. The settings presented here simply illustrate the sample configuration and are not intended to be prescriptive. The **Voicemail Type** in the sample configuration is “Voicemail Lite/Pro”. Other Voicemail types may be used. The Voicemail IP Address in the sample configuration is 10.80.150.182, the IP Address of the PC running the Voicemail Pro software, as shown in Figure 1.

In the sample configuration, the “Callback” application of Avaya Voicemail Pro was used to allow Voicemail Pro to call out via the SIP Line to Verizon Business when a message is left in a voice mailbox. The **SIP Settings** shown in the screen below enable IP Office to populate the SIP headers for an outbound “callback” call from Voicemail Pro, similar to the way the fields with these same names apply to calls made from telephone users (e.g., see Section 5.5).
5.3.4. System Telephony Configuration

To view or change telephony settings, select the Telephony tab and Telephony sub-tab as shown in the following screen. The settings presented here simply illustrate the sample configuration and are not intended to be prescriptive. In the sample configuration, the Inhibit Off-Switch Forward/Transfer box is unchecked so that call forwarding and call transfer to PSTN destinations via the Verizon Business IP Trunk service can be tested. That is, a call can arrive to IP Office via the Verizon Business IP Trunk, and be forwarded or transferred back to the PSTN with the outbound leg of the call using the Verizon IP Trunk service. The Companding Law parameters are set to “ULAW” as is typical in North American locales. Other parameters on this screen may be set according to customer requirements.

The Default Name Priority is a new field in IP Office Release 8 and can be relevant to SIP Trunking. The option to “Favor Trunk” or “Favor Directory” can be set system-wide using the screen below, or set uniquely for each line. With the option to “Favor Directory”, IP Office will prefer to display names found in a personal or system directory over those arriving from the far-end, if there is a directory match to the caller ID. This capability will be illustrated further in the context of the SIP Line to Verizon.

5.3.5. System Twinning Configuration

To view or change Twinning settings, select the Twinning tab as shown in the following screen.
The **Send original calling party information for Mobile Twinning** box is not checked in the sample configuration, and the **Calling party information for Mobile Twinning** is left blank. With this configuration, and related configuration of “Diversion header” on the SIP Line (Section 5.4), the true identity of a PSTN caller can be presented to the twinning destination (e.g., a user’s mobile phone) when a call is twinned out via the Verizon Business IP Trunk service.

5.3.6. **System Codecs Configuration**

The **System → Codecs** tab was introduced in IP Office Release 8. On the left, observe the list of **Available Codecs**. In the example screen below, which is not intended to be prescriptive, the box next to each codec is checked, making all the codecs available in other screens where codec configuration may be performed (such as the SIP Line in Section 5.4). The **Default Codec Selection** area enables the codec preference order to be configured on a system-wide basis, using the up, down, left, and right arrows. By default, all IP (SIP and H.323) lines and extensions will assume the system default codec selection, unless configured otherwise for the specific line or extension.

5.4. **SIP Line**

This section shows the configuration screens for the SIP Line in IP Office Release 8.1. The Appendix in Section 11 contains an example SIP Trunk template file that was generated from the SIP Line configured in this section.

To add a new SIP Line, right click on **Line** in the Navigation pane, and select **New → SIP Line**.
A new Line Number will be assigned automatically. To edit an existing SIP Line, click **Line** in the Navigation pane, and the SIP Line to be configured in the Group pane.

### 5.4.1. SIP Line – SIP Line Tab

The **SIP Line** tab in the Details pane is shown below for Line Number 20, used for Avaya SBCE to the Verizon Business IP Trunk service. The **ITSP Domain Name** may be left blank as Avaya SBCE does not require a domain name. IP Office will use the IP address of the LAN setting in Section 5.3.2 to populate the domain part of the SIP URI when the **ITSP Domain Name** is left blank. The **Send Caller ID** parameter is set to “Diversion Header”. With this setting and the related configuration in Section 5.3.5, IP Office will include the Diversion Header for calls that are directed via Mobile Twinning out the SIP Line to Verizon. The Diversion Header will contain the number associated with the Twinning user, allowing Verizon to admit the call, and the From Header will be populated with the true calling party identity, allowing the twinning destination (e.g., mobile phone) to see the true caller id. IP Office will also include the Diversion header for calls that are call forwarded out the SIP Line to Verizon. The **Call Routing Method** can retain the default “Request URI” setting, or may be changed to “To Header”, to match Incoming Call Routes based on the contents of the “To Header”. In the sample configuration, the default “Request URI” setting was used.

The area of the screen entitled **REFER Support** was introduced in IP Office Release 6.1. The default automatic determination of REFER support is “Auto”. Alternatively, the default can be overridden with “Never” to explicitly disable use of REFER, or “Always” to explicitly enable use of REFER. The **Association Method** parameter was introduced in IP Office Release 7.0, and the screen below shows the value “Always” set in the sample configuration. The various alternatives for the **Association Method** may be useful when multiple SIP Trunks with different SIP domains resolve to a single IP Address. The default option associates incoming requests with SIP Lines by comparing the source IP Address and port of the incoming message against the configured far-end of the SIP Line.

The **Name Priority** parameter was introduced in IP Office Release 8.0. The **Name Priority** parameter can retain the default “System Default” setting, or can be configured to “Favor Trunk” or “Favor Directory” as shown in the sample screen below. “System Default” will use the setting displayed on the System → Telephony → Telephony Tab. The “Favor Directory” setting enables IP Office to match the caller’s telephone number against available system or personal directories, and display the name obtained from a match in the directory, if any, rather than name information received in the SIP signaling from Verizon. Click **OK** (not shown).
5.4.2. SIP Line - Transport Tab

Select the Transport tab. This tab was introduced in Release 6.1. Some information configured in this tab had been under the SIP Line tab in Release 6.0.

The ITSP Proxy Address is set to the inside IP address of the Avaya SBCE as shown in Figure 1. In the Network Configuration area, TCP is selected as the Layer 4 Protocol. The Send Port can retain the default value 5060. The Use Network Topology Info parameter is set to “None”.

![SIP Line - Transport Tab](image)
5.4.3. SIP Line - SIP URI Tab

Select the SIP URI tab. To add a new SIP URI, click the Add… button. In the bottom of the screen, a New Channel area will be opened. To edit an existing entry, click an entry in the list at the top, and click the Edit… button. In the bottom of the screen, the Edit Channel area will be opened. In the example screen below, a previously configured entry is edited. “Use Internal Data” is selected for the Local URI, Contact, and Display Name. Information configured on the SIP Tab for individual users will be used to populate the SIP headers. The PAI parameter was introduced in IP Office Release 6.1, and the value “None” is shown selected from the drop-down menu. With PAI set to “None”, IP Office Release 6.1 and above will behave like IP Office Release 6.0 with respect to the SIP P-Asserted-Identity header (e.g., IP Office will not include a PAI header for an outbound call unless privacy is asserted). If the optional Verizon “unscreened ANI” feature is configured for the Verizon service, the PAI parameter may be set to the specific Screened Telephone Number (STN) provided by Verizon. The Registration parameter is set to the default “0: <None>” since Verizon Business IP Trunk service does not require registration. The Incoming Group parameter, set here to 20, will be referenced when configuring Incoming Call Routes to map inbound SIP trunk calls to IP Office destinations in Section 5.7. The Outgoing Group parameter, set here to 20, will be used for routing outbound calls to Verizon via the Short Codes (Section 5.6) or ARS configuration (Section 5.8). The Max Calls per Channel parameter, configured here to 10, sets the maximum number of simultaneous calls that can use the URI before IP Office returns busy to any further calls. Click OK.
In the sample configuration, the single SIP URI shown above was sufficient to allow incoming calls for Verizon DID numbers destined for specific IP Office users or IP Office hunt groups. The calls are accepted by IP Office since the incoming number will match the SIP Name configured for the user or hunt group that is the destination for the call. Channels 2 and 3 display service numbers, such as a DID number routed directly to voicemail or DID used for Mobile Call Control. DID numbers that IP Office should admit can be entered into the Local URI and Contact fields instead of “Use Internal Data”. The numbers 732-945-0239 and 732-945-0240 will be assigned as service numbers in the Incoming Call Routes in Section 5.7.

5.4.4. SIP Line - VoIP Tab
Select the VoIP tab. The Codec Selection drop-down box → System Default (default) when selected will match the codecs set in the system wide Default Selection list (System → CODECS). In the sample configuration, Custom was selected and codecs preferred by Verizon were included as well as the newly supported G.722 codec (i.e., G.722 64K, G729(a) 8K CS-ACELP and G.711 U/LAW 64K). This will cause IP Office to include G.722, G.729a and G.711MU in the Session Description Protocol (SDP) offer, in that order. Set the Fax Transport Support drop-down to “T38 Fallback”. This enables T.38 to be used if supported and will fall-back to G.711 if not. If using T.38 fax, the T38 Fax tab must be visited and the Disable T30 ECM option checked or fax failures using T38 may occur (See Section 5.4.5 and Section 2.2 for further information). The DTMF Support parameter can remain set to the default value.
“RFC2833”. The **Re-invite Supported** parameter can be checked to allow for codec renegotiation in cases where the target of an incoming call or transfer does not support the codec originally negotiated on the trunk. The **Re-invite Supported** parameter should be checked if the SIP Line will be used for fax. For PSTN originations, Verizon preferred the G.729a codec in the SDP, while also allowing the G.711MU codec. However, if an originator is at a SIP connected location and offers G.722, Verizon will preserve this offer and allow G.722 to be negotiated and used end to end. During testing, the IP Office configuration was varied such that G.711MU was the preferred or only codec listed, and G.711MU calls were also successfully verified. The **Codec Lockdown** parameter was new in IP Office Release 7 and may retain the default unchecked value. Click **OK** (not shown).

### 5.4.5. T38 Fax

The settings on this tab are only accessible if **Re-invite Supported** is checked and a value for **Fax Transport Support** other than “None” are selected on the **VoIP** tab. Fax relay is only supported on IP500/IP500 V2 systems with an IP500 VCM card. The **Disable T30 ECM** must be checked or fax errors may be experienced when using T38 Fax (See Section 2.2 for further information). When selected, it disables the T.30 Error Correction Mode used for fax transmission. All other values are left at default.
5.5. Users, Extensions, and Hunt Groups

In this section, examples of IP Office Users, Extensions, and Hunt Groups will be illustrated. In the interests of brevity, not all users and extensions shown in Figure 1 will be presented, since the configuration can be easily extrapolated to other users. To add a User, right click on User in the Navigation pane, and select New. To edit an existing User, select User in the Navigation pane, and select the appropriate user to be configured in the Group pane.

5.5.1. Digital User 232

The following screen shows the User tab for User 232. As shown in Figure 1, this user corresponds to the Avaya Digital 9508.
The following screen shows the SIP tab for User 232. The **SIP Name** and **Contact** parameters are configured with the DID number of the user, 732-945-0232. These parameters configure the user part of the SIP URI in the From header for outgoing SIP trunk calls, and allow matching of the SIP URI for incoming calls, without having to enter this number as an explicit SIP URI for the SIP Line. The **SIP Display Name (Alias)** parameter can optionally be configured with a descriptive name. If all calls involving this user and a SIP Line should be considered private, then the **Anonymous** box may be checked to withhold the user’s information from the network. See Section 5.6 for a method of using a short code (rather than static user provisioning) to place an anonymous call.
From **Figure 1**, note that user 232 will use the Mobile Twinning feature. The following screen shows the **Mobility** tab for User 232. The **Mobility Features** and **Mobile Twinning** boxes are checked. The **Twinned Mobile Number** field is configured with the number to dial to reach the twinned mobile telephone, in this case 913035387024. Other options can be set according to customer requirements.
The following screen shows the Extension information for this user. To view, select **Extension** from the Navigation pane, and the appropriate extension from the Group pane.

<table>
<thead>
<tr>
<th>Extension</th>
<th>Digital Extension: 26 232</th>
</tr>
</thead>
<tbody>
<tr>
<td>Id</td>
<td>Extension</td>
</tr>
<tr>
<td>1</td>
<td>231</td>
</tr>
<tr>
<td>2</td>
<td>202</td>
</tr>
<tr>
<td>3</td>
<td>203</td>
</tr>
<tr>
<td>4</td>
<td>204</td>
</tr>
<tr>
<td>5</td>
<td>205</td>
</tr>
<tr>
<td>6</td>
<td>206</td>
</tr>
<tr>
<td>7</td>
<td>207</td>
</tr>
<tr>
<td>8</td>
<td>208</td>
</tr>
<tr>
<td>9</td>
<td>232</td>
</tr>
<tr>
<td>10</td>
<td>210</td>
</tr>
<tr>
<td>11</td>
<td>211</td>
</tr>
<tr>
<td>12</td>
<td>212</td>
</tr>
<tr>
<td>13</td>
<td>213</td>
</tr>
<tr>
<td>14</td>
<td>214</td>
</tr>
<tr>
<td>15</td>
<td>215</td>
</tr>
<tr>
<td>16</td>
<td>216</td>
</tr>
<tr>
<td>25</td>
<td>235</td>
</tr>
<tr>
<td>26</td>
<td>236</td>
</tr>
<tr>
<td>27</td>
<td>237</td>
</tr>
<tr>
<td>28</td>
<td>238</td>
</tr>
<tr>
<td>29</td>
<td>239</td>
</tr>
<tr>
<td>30</td>
<td>240</td>
</tr>
<tr>
<td>31</td>
<td>241</td>
</tr>
<tr>
<td>32</td>
<td>242</td>
</tr>
</tbody>
</table>

### 5.5.2. SIP Telephone User (Avaya 1140E)

A new SIP extension may be added by right-clicking on **Extension** in the Navigation pane and selecting **New SIP Extension**. Alternatively, an existing SIP extension may be selected in the group pane. The following screen shows the **Ext** tab for the extension corresponding to an Avaya 1140E. The **Base Extension** field is populated with 1145, the extension assigned to the Avaya 1140E. Ensure the **Force Authorization** box is checked.

The following screen shows the **VoIP** tab for the extension. The **IP Address** field may be left blank. Check the **Reserve Avaya IP endpoint license** box. The new **Codec Selection** parameter may retain the default setting “System Default” to follow the system configuration shown in Section 5.4.3. Alternatively, “Custom” may be selected to allow the codecs to be configured for...
this extension, using the arrow keys to select and order the codecs. Other fields may retain default values.

The following screen shows the User tab for User 235 corresponding to an Avaya 1140E. The Extension parameter is populated with extension 235.
Select the **Telephony** tab. Then select the **Supervisor Settings** tab as shown below. The **Login Code** will be used by the Avaya 1140E telephone user as the login password.
Remaining in the **Telephony** tab for the user, select the **Call Settings** tab as shown below. Check the **Call Waiting On** box to allow multiple call appearances and transfer operations.
Like other users previously illustrated, the **SIP** tab for the user with extension 235 is configured with a **SIP Name** and **Contact** specifying the user’s Verizon IP Trunk service DID number.

![Avaya140E: 235](image)

### 5.5.3. Hunt Groups

During the verification of these Application Notes, users could also receive incoming calls as members of a hunt group. To configure a new hunt group, right-click **HuntGroup** from the Navigation pane, and select **New**. To view or edit an existing hunt group, select **HuntGroup** from the Navigation pane, and the appropriate hunt group from the Group pane.

The following screen shows the **Hunt Group** tab for hunt group 401. These telephone extensions are rung in order, one after the other. However, the last extension used is remembered. The next call received rings the next extension in the list, due to the **Ring Mode** setting “Rotary” (previously called Circular). Click the **Edit** button to change the **User List**.
The following screen shows the SIP tab for hunt group 401. The **SIP Name** and **Contact** are configured with Verizon DID 7329450242. Later, in Section 5.7, an Incoming Call Route will map 7329450242 to this hunt group based on the information entered on this tab.
5.6. Short Codes

In this section, various examples of IP Office short codes will be illustrated. To add a short code, right click on **Short Code** in the Navigation pane, and select **New**. To edit an existing short code, click **Short Code** in the Navigation pane, and the short code to be configured in the Group pane.

In the screen shown below, the short code “8N;” is illustrated. The **Code** parameter is set to “8N;”. The **Feature** parameter is set to “Dial”. The **Telephone Number** parameter is set to “N”. The **Telephone Number** field is used to construct the Request URI and To Header in the outgoing SIP INVITE message. The **Line Group ID** parameter is set to 20, matching the number of the **Outgoing Group** configured on the **SIP URI** tab of SIP Line 20 to Avaya SBCE (Section 5.4).

This simple short code will allow an IP Office user to dial the digit 8 followed by any telephone number, symbolized by the letter N, to reach the SIP Line to Verizon business. “N” can be any number such as a 10-digit number, a 1+10 digit number, a toll free number, directory assistance (e.g., 411), etc. This short code approach has the virtue of simplicity, but does not provide for alternate routing or an awareness of end of user dialing. When users dial 8 plus the number, IP Office must wait for an end of dialing timeout before sending the SIP INVITE to Verizon Business. Click the OK button (not shown).

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Short Code</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Code</strong></td>
<td>8N;</td>
</tr>
<tr>
<td><strong>Feature</strong></td>
<td>Dial</td>
</tr>
<tr>
<td><strong>Telephone Number</strong></td>
<td>N</td>
</tr>
<tr>
<td><strong>Line Group ID</strong></td>
<td>20</td>
</tr>
<tr>
<td><strong>Locate</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Force Account Code</strong></td>
<td>☑</td>
</tr>
</tbody>
</table>
The simple “8N;” short code previously illustrated does not provide a means of alternate routing if the configured SIP Line is out of service or temporarily not responding. When alternate routing options and/or more customized analysis of the digits following the short code are desired, the Automatic Route Selection (ARS) feature may be used. In the following example screen, the short code “9N” is illustrated for access to ARS. When the Avaya IP Office user dials 9 plus any number “N”, rather than being directed to a specific Line Group Id, the call is directed to “50: Main”, configurable via ARS. See Section 5.8 for example ARS route configuration for 50: Main as well as a backup route.

Optionally, add or edit a short code that can be used to access the SIP Line anonymously. In the screen shown below, the short code “*67N;” is illustrated. This short code is similar to the “8N;” short code except that the Telephone Number field begins with the letter “W”, which means “withhold the outgoing calling line identification”. In the case of the SIP Line to Verizon documented in these Application Notes, when a user dials *67 plus any number “N”, IP Office will include the user’s telephone number in the P-Asserted-Identity (PAI) header along with “Privacy: Id”. Verizon will allow the call due to the presence of a valid DID in the PAI header, but will prevent presentation of the caller id to the called PSTN destination.
The following screen illustrates a short code that acts like a feature access code rather than a means to access a SIP Line. In this case, the Code “FNE31” is defined for Feature “FNE Service” to Telephone Number “31” (Mobile Call Control). This short code will be used as means to allow a Verizon DID to be programmed to route directly to this feature, via inclusion of this short code as the destination of an Incoming Call Route. See Section 5.7. This feature is used to provide dial tone to twinned mobile devices (e.g., cell phone) directly from IP Office; once dial tone is received the user can perform dialing actions including making calls and activating Short Codes.

5.7. Incoming Call Routes
In this section, IP Office Incoming Call Routes are illustrated. To add an incoming call route, right click on Incoming Call Route in the Navigation pane, and select New. To edit an existing incoming call route, select Incoming Call Route in the Navigation pane, and the appropriate incoming call route to be configured in the Group pane.

In the screen shown below, a simple incoming call route is illustrated. The Line Group Id is 20, matching the Incoming Group field configured in the SIP URI tab for the SIP Line to Verizon Business in Section 5.4.2. The Incoming Number field is left blank to match all details of the To header.
The following **Destinations** tab for the incoming call route contains the **Destination** “.” entered manually. This will match the **Incoming Number** field as the Destination and route the call based on the information in the SIP tab for the User or hunt group as illustrated in Section 5.5.

![Incoming Call Route](image1)

In the screen shown below, the incoming call route for **Incoming Number** “732945039” is illustrated. The **Line Group Id** is 20, matching the Incoming Group field configured in the SIP URI tab for the SIP Line to Verizon Business in Section 5.4.2.

![Incoming Call Route](image2)

The following **Destinations** tab for the incoming call route contains the **Destination** “VM:DayAA” entered manually. An incoming call to 732-945-0239 will be delivered directed to the Voicemail Pro Module “DayAA”.

![Incoming Call Route](image3)
Similarly, the following **Destinations** tab for an incoming call route contains the **Destination** “FNE31” entered manually. The name “FNE31” is the short code for accessing the “Mobile Call Control” application and 732-945-0240 was configured in Section 5.4.2 on the SIP URI tab as an incoming number. An incoming call to 732-945-0240 will be delivered directly to internal dial tone from the IP Office, allowing the caller to perform dialing actions including making calls and activating Short Codes. The incoming caller ID must match the Twinned Mobile Number entered in the User Mobility tab in Section 5.5.1; otherwise the IP Office responds with a 486 Busy Here and the caller will hear a busy tone.

5.8. **ARS and Alternate Routing**

While detailed coverage of ARS is beyond the scope of these Application Notes, this section includes basic ARS screen illustrations and considerations. ARS is illustrated here mainly to illustrate alternate routing should the SIP Line be out of service or temporarily not responding.

Optionally, Automatic Route Selection (ARS) can be used rather than the simple “8 N;” short code approach documented in Section 5.6. With ARS, secondary dial tone can be provided after the access code, time-based routing criteria can be introduced, and alternate routing can be specified so that a call can re-route automatically if the primary route or outgoing line group is not available. ARS also facilitates more specific dialed telephone number matching, enabling immediate routing and alternate treatment for different types of numbers following the access code. For example, if all 1+10 digit calls following an access code should use the SIP Line preferentially, but other local or service numbers following the access code should prefer a different outgoing line group, ARS can be used to distinguish the call behaviors.

To add a new ARS route, right-click **ARS** in the Navigation pane, and select **New**. To view or edit an existing ARS route, select **ARS** in the Navigation pane, and select the appropriate route name in the Group pane.
The following screen shows an example ARS configuration for the route named “Main”. The In Service parameter refers to the ARS form itself, not the Line Groups that may be referenced in the form. If the In Service box is un-checked, calls are routed to the ARS route name specified in the Out of Service Route parameter. IP Office short codes may also be defined to allow an ARS route to be disabled or enabled from a telephone. The configurable provisioning of an Out of Service Route and the means to manually activate the Out of Service Route can be helpful for scheduled maintenance or other known service-affecting events for the primary route.

Assuming the primary route is in-service, the number passed from the short code used to access ARS (e.g., 9N in Section 5.6) can be further analyzed to direct the call to a specific Line Group ID. Per the example screen above, if the user dialed 9-1-303-538-1000, the call would be directed to Line Group 20. If Line Group 20 cannot be used, the call can automatically route to the route name configured in the Alternate Route parameter in the lower right of the screen.

Since alternate routing can be considered a privilege not available to all callers, IP Office can control access to the alternate route by comparing the calling user’s priority to the value in the Alternate Route Priority Level field.

The following screen shows an example ARS configuration for the route named “backup”, ARS Route ID 52. Continuing the example, if the user dialed 9-1-303-538-1000, and the call could not be routed via the primary route “50: Main” described above, the call will be delivered to this “backup” route. Per the configuration shown below, the call will be delivered to Line Group 0.
using the analog lines. The configuration of the **Code**, **Telephone Number**, **Feature**, and **Line Group ID** for an ARS route is similar to the configuration already shown for short codes in Section 5.6.

If a primary route experiences a network outage such that no response is received to an outbound INVITE, IP Office successfully routes the call via the backup route. The user receives an audible tone when the re-routing occurs and may briefly see “Waiting for Line” on the display.

### 5.9. Privacy / Anonymous Calls

There are multiple methods for a user to withhold outgoing identification:

- **Dialing the short code "+67 to access the SIP Line.** (Section 5.6)
- **Specific users may be configured to always withhold calling line identification by checking the Anonymous field in the SIP tab for the user** (Section 5.5).
- **Avaya Telephones equipped with a “Features” button can also request privacy for a specific call, without dialing a unique short code, using Features ➔ Call Settings ➔ Withhold Number**, on the phone itself.

To configure IP Office to include the caller’s DID number in the P-Asserted-Identity SIP header, required by Verizon Business to admit an otherwise anonymous caller to the network, the following procedure may be used.
From the Navigation pane, select User. From the Group pane, scroll down past the configured users and select the user named NoUser. From the NoUser Details pane, select the tab Source Numbers. Press the Add… button to the right of the list of any previously configured Source Numbers. In the Source Number field shown below, type SIP_USE_PAI_FOR_PRIVACY. Click OK.

The source number SIP_USE_PAI_FOR_PRIVACY should now appear in the list of Source Numbers as shown below.

5.10. Saving Configuration Changes to IP Office

Navigate to File → Save Configuration in the menu bar at the top of the screen to save the configuration performed in the preceding sections.

The following will appear, with either Merge or Immediate selected, based on the nature of the configuration changes made since the last save. Note that clicking OK may cause a service disruption. Click OK if desired.
6. Configure Avaya Session Border Controller for Enterprise

This section covers the configuration of the Avaya SBCE. It is assumed that the Avaya SBCE software has already been installed.

Use a WEB browser to access the Element Management Server (EMS) web interface, and enter https://<ip-addr>/sbc in the address field of the web browser, where <ip-addr> is the management LAN IP address of the Avaya SBCE.

Log in with the appropriate credentials. Click Log In.

The Dashboard for the Avaya SBCE will appear.
To view system information that was configured during installation, navigate to System Management. A list of installed devices is shown in the right pane. In the case of the sample configuration, a single device named Micro SBC is shown. To view the configuration of this device, click View as highlighted below.

The System Information screen shows the Network Configuration, DNS Configuration and Management IP(s) information provided during installation and corresponds to Figure 1. The Box Type was set to SIP and the Deployment Mode was set to Proxy. Default values were used for all other fields.
6.1. Network Management

The Network Management screen is where the network interface settings are configured and enabled. During the installation process of Avaya SBCE, certain network-specific information is defined such as device IP address(es), public IP address(es), netmask, gateway, etc. to interface the device to the network. It is this information that populates the various Network Management tab displays, which can be edited as needed to optimize device performance and network efficiency. Navigate to **Device Specific Settings** → **Network Management** and verify the IP addresses assigned to the interfaces and that the interfaces are enabled. The following screen shows the enterprise interface is assigned to A1 and the interface towards Verizon is assigned to B1.

![Network Management Screenshot](image)

The following screen shows interface **A1** and **B1** are **Enabled**. To enable an interface click the corresponding **Toggle** button.

![Network Management Table](image)
6.2. Routing Profile
Routing profiles define a specific set of packet routing criteria that are used in conjunction with other types of domain policies to identify a particular call flow and thereby ascertain which security features will be applied to those packets. Parameters defined by Routing Profiles include packet transport settings, name server addresses and resolution methods, next hop routing information, and packet transport types.

Create a Routing Profile for IP Office and Verizon Business IP Trunk service. To add a routing profile, navigate to Global Profiles → Routing and select Add. Enter a Profile Name and click Next to continue.

The following screen shows the Routing Profile to Verizon. In the Next Hop Server 1 field enter the Fully Qualified Domain Name that Verizon uses to listen for SIP traffic. In the sample configuration “pcelban0001.avayalincroft.globalipcom.com” was used. Uncheck the Routing Priority based on Next Hop Server box. Select SRV and enter UDP for the Outgoing Transport field.
Similarly add a Routing Profile to IP Office.

The following screen shows the Routing Profile to IP Office. The **Next Hop Server 1** IP address must match the IP address of the IP Office LAN settings entered in Section 5.3.2. Leave the **Routing Priority based on Next Hop Server** box checked. The **Outgoing Transport** is set to “TCP” and matches the **Layer 4 Protocol** set in IP Office SIP Line →Transport in Section 5.4.2.
6.3. Server Interworking Profile

The Server Interworking profile configures and manages various SIP call server-specific parameters such as TCP and UDP port assignments, heartbeat signaling parameters (for HA deployments), DoS security statistics, and trusted domains. Interworking Profile features are configured based on different Trunk Servers. There are default profiles available that may be used as is, or new profiles can be configured as described below.

In the sample configuration, separate Server Interworking Profiles were created for IP Office and Verizon Business IP Trunk service.

6.3.1. Server Interworking Profile – IP Office

In the sample configuration, the IP Office Server Interworking profile was cloned from the default avaya-ru profile. To clone a Server Interworking Profile for IP Office, navigate to Global Profiles → Server Interworking, select the avayu-ru profile and click the Clone button. Enter a Clone Name and click Next to continue.
In the new window that appears, check the **T.38 Support** field. Use default values for all remaining fields. Click **Next** to continue.

Default values can be used for the next windows that appear. Click **Next** to continue, then Finish to save the changes (not shown).

### 6.3.2. Server Interworking Profile – Verizon

To create a new Server Interworking Profile for Verizon, navigate to **Global Profiles → Server Interworking** and click **Add** as shown below. Enter a **Profile Name** and click **Next**.
In the new window that appears, check the **T.38 Support** field. Use default values for all remaining fields. Click **Next** to continue.

Default values can be used for the Privacy and DTMF sections. Click **Next** to continue.
The following screen shows the values used for compliance testing for the **Trans Expire** field. The **Trans Expire** timer sets the allotted time the Avaya SBCE will try the first primary server before trying the secondary server. Click **Finish** to save the changes.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trans Expire</td>
<td>3</td>
</tr>
</tbody>
</table>

The Interworking Profile screen is shown above, which includes fields for **Privacy** and **DTMF**. Click **Finish** to save changes.
On the Advanced Settings window uncheck the Topology Hiding: Change Call-ID and Change Max Forwards boxes. Click Finish to save changes.

6.4. Server Configuration

The Server Configuration screen contains four tabs: General, Authentication, Heartbeat, and Advanced. Together, these tabs configure and manage various SIP call server-specific parameters such as TCP and UDP port assignments, heartbeat signaling parameters, DoS security statistics, and trusted domains.

In the sample configuration, separate Server Configurations were created for IP Office and Verizon Business IP Trunk service.

6.4.1. Server Configuration – IP Office

To add a Server Configuration Profile for IP Office, navigate to Global Profiles → Server Configuration and click Add. Enter a descriptive name for the new profile and click Next.
The following screens illustrate the Server Configuration for the Profile name “IP Office”. In the **General** parameters, select “Call Server” from the **Server Type** drop-down menu. In the **IP Addresses / Supported FQDNs** area, the IP Address of the IP Office LAN 1 interface in the sample configuration is entered. This IP address is 10.80.150.70. In the **Supported Transports** area, TCP is selected, and the **TCP Port** is set to “5060”. If adding a new profile, click Next. If editing an existing profile, click Finish (not shown).
In the next two windows that appear, verify **Enable Authentication** and **Enable Heartbeat** is unchecked. IP Office does not require authentication and the Heartbeat feature is not necessary because Avaya SBCE will forward SIP OPTIONS from Verizon to the IP Office. Click **Next** to continue.

In the new window that appears, select the **Interworking Profile** created for IP Office in Section 6.3.1. Use default values for all remaining fields. Click **Finish** to save the configuration.

**6.4.2. Server Configuration - Verizon**

To add a Server Configuration Profile for Verizon, navigate to **Global Profiles** → **Server Configuration** and click **Add**. Enter a descriptive name for the new profile and click **Next**.

The following screens illustrate the Server Configuration for the Profile name “Verizon-IPT”. In the **General** parameters, select “Trunk Server” from the **Server Type** drop-down menu. In the
**IP Addresses / Supported FQDNs** area, the Verizon-provided IP trunk Fully Qualified Domain Name is entered. This is “pcelban0001.avayalincroft.globalipcom.com”. In the **Supported Transports** area, UDP is selected, and the **UDP Port** is set to “5071”. If adding a new profile, click Next. If editing an existing profile, click Finish (not shown).

![Add Server Configuration Profile - General](image)

<table>
<thead>
<tr>
<th>Server Type</th>
<th>Trunk Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Addresses / Supported FQDNs</td>
<td>pcelban0001.avayalincroft.globalipcom.com</td>
</tr>
<tr>
<td>Supported Transports</td>
<td>TCP, UDP, TLS</td>
</tr>
<tr>
<td>TCP Port</td>
<td></td>
</tr>
<tr>
<td>UDP Port</td>
<td>5071</td>
</tr>
<tr>
<td>TLS Port</td>
<td></td>
</tr>
</tbody>
</table>

[Back] [Next]
Verify **Enable Authentication** is unchecked as Verizon does not require authentication. Click **Next** to continue.

<table>
<thead>
<tr>
<th>Enable Authentication</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>User Name</td>
<td></td>
</tr>
<tr>
<td>Realm (Leave blank to detect from server challenge)</td>
<td></td>
</tr>
<tr>
<td>Password</td>
<td></td>
</tr>
<tr>
<td>Confirm Password</td>
<td></td>
</tr>
</tbody>
</table>

In the new window that appears, check the **Enable Heartbeat** box. Select “OPTIONS” from the **Method** drop-down menu. Select the desired frequency that the SBC will source OPTIONS. The **From URI** and **To URI** may be filled in to configure easily identifiable URIs to appear in SIP OPTIONS sourced by the SBC. Click **Next** to continue.

<table>
<thead>
<tr>
<th>Enable Heartbeat</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Method</td>
<td>OPTIONS</td>
</tr>
<tr>
<td>Frequency</td>
<td>60 seconds</td>
</tr>
<tr>
<td>From URI</td>
<td>PING@2.2.2.2</td>
</tr>
<tr>
<td>To URI</td>
<td><a href="mailto:PING@pcelban0001.avaya.com">PING@pcelban0001.avaya.com</a></td>
</tr>
</tbody>
</table>
In the new window that appears, select the **Interworking Profile** “Vz-Interwrk” created previously in Section 6.3.2. Use default values for all remaining fields. Click **Finish** to save the configuration.

6.5. Media Rule
Media Rules define RTP media packet parameters such as prioritizing encryption techniques and packet encryption techniques. Together these media-related parameters define a strict profile that is associated with other SIP-specific policies to determine how media packets matching these criteria will be handled by the Avaya SBCE security product.

Select **Domain Policies → Media Rules** from the left-side menu as shown below. In the sample configuration, a single default media rule “default-low-med” was used with the DSCP values “EF” for expedited forwarding set for **Media QoS** as shown below.
6.6. Signaling Rule

Signaling Rules define the action to be taken (Allow, Block, Block with Response, etc.) for each type of SIP-specific signaling request and response message. When SIP signaling packets are received by Avaya SBCE, they are parsed and “pattern-matched” against the particular signaling criteria defined by these rules. Packets matching the criteria defined by the Signaling Rules are tagged for further policy matching.

Clone and modify the default signaling rule to add the proper quality of service to the SIP signaling. To clone a signaling rule, navigate to Domain Policies ➔ Signaling Rules. With the default rule chosen, click Clone (not shown). Enter a descriptive name for the new rule and click Finish.

In the sample configuration, signaling rule “default_QoS_AF32” was used with the DSCP values “AF32” for assured forwarding set for Signaling QoS as shown below.

6.7. Application Rule

Application Rules define which types of SIP-based Unified Communications (UC) applications the Avaya SBCE security device will protect: voice, video, and/or Instant Messaging (IM). In addition, you can determine the maximum number of concurrent voice and video sessions the network will process in order to prevent resource exhaustion.
Select **Domain Policies → Application Rules** from the left-side menu as shown below. In the sample configuration, a single default application rule “default-trunk” was used and will be applied to the Endpoint Policy Group in the next section.

**6.8. Endpoint Policy Groups**

The rules created within the Domain Policy section are assigned to an Endpoint Policy Group. The Endpoint Policy Group is then applied to a Server Flow in Section 6.11.

To create a new policy group, navigate to **Domain Policies → Endpoint Policy Groups** and click on **Add** as shown below. In the sample configuration “SIP-Trunk-Policy” was created using defaults selected for all fields, with the exception of **Application** set to “default-trunk”, and **Signaling**, which was set to “default_QoS_AF32” as shown below. The details of the non-default rules chosen are shown in previous sections.
6.9. Media Interface

The Media Interface screen is where the SIP media ports are defined. Avaya SBCE will send SIP media on the defined ports. Create a SIP media interface for the inside and outside IP interfaces.

To create a new Media Interface, navigate to **Device Specific Settings → Media Interface** and click **Add**. The following screen shows the media interfaces defined for the sample configuration.

After the media interfaces are created, an application restart is necessary before the changes will take effect. Navigate to **System Management** and click **Restart Application** as highlighted below.
6.10. Signaling Interface

The Signaling Interface screen is where the SIP signaling ports are defined. Avaya SBCE will listen for SIP requests on the defined ports. Create a signaling interface for the inside and outside IP interfaces.

To create a new Signaling Interface, navigate to Device Specific Settings → Signaling Interface and click Add. The following screen shows the signaling interfaces defined for the sample configuration.

![Signaling Interface Screen](image)

6.11. End Point Flows - Server Flow

When a packet is received by Avaya SBCE, the content of the packet (IP addresses, URIs, etc.) is used to determine which flow it matches. Once the flow is determined, the flow points to a policy which contains several rules concerning processing, privileges, authentication, routing, etc. Once routing is applied and the destination endpoint is determined, the policies for this destination endpoint are applied. The context is maintained, so as to be applied to future packets in the same flow. The following screen illustrates the flow through the SBC to secure a SIP Trunk call.

![End Point Flows Screen](image)
Create a Server Flow for IP Office and Verizon Business IP Trunk service. To create a Server Flow, navigate to **Device Specific Settings** → **End Point Flows**. Select the **Server Flows** tab and click **Add** as highlighted below.

The following screen shows the flow named “Verizon IPT Flow” being added to the sample configuration. This flow uses the interfaces, policies, and profiles defined in previous sections. **Click Finish.**
Once again, select the **Server Flows** tab and click **Add**. The following screen shows the flow named “IP Office Flow” being added to the sample configuration. This flow uses the interfaces, polices, and profiles defined in previous sections. Click **Finish**.

![Edit Flow: IP Office Flow](image)

The following screen summarizes the Server Flows configured in the sample configuration.
7. Verizon Business Configuration

Information regarding Verizon Business IP Trunk service offer can be found by contacting a Verizon Business sales representative, or by visiting http://www.verizonbusiness.com/us/products/voip/trunking/.

The reference configuration described in these Application Notes was located in the Avaya Solutions and Interoperability Lab. The Verizon Business IP trunk service was accessed via a Verizon Private IP (PIP) T1 connection. Verizon Business provided the necessary service provisioning.

The following Fully Qualified Domain Names (FQDNs) were provided by Verizon for the reference configuration.

<table>
<thead>
<tr>
<th>CPE (Avaya)</th>
<th>Verizon Network</th>
</tr>
</thead>
<tbody>
<tr>
<td>adevc.avaya.globalipcom.com</td>
<td>pcelban0001.avayalincroft.globalipcom.com</td>
</tr>
</tbody>
</table>

For service provisioning, Verizon will require the customer IP address used to reach the Avaya SBCE. Verizon provided the following information for the compliance testing: the IP address and port used by the Verizon SIP SBC, DNS server information, and the Direct Inward Dialed (DID) numbers shown in Figure 1 and Table 1. This information was used to complete the Avaya IP Office configuration shown in Section 5.
8. Verifications

This section provides example verifications of the Avaya configuration with Verizon Business Private IP (PIP) Trunk service.

8.1. Illustration of OPTIONS Handling

The following screens from a filtered Wireshark trace illustrate OPTIONS sent by Verizon to the CPE. Verizon IP Trunk service uses OPTIONS to determine whether the CPE is available to receive inbound calls. Therefore, proper OPTIONS response is necessary. In the trace shown below, taken from the outside interface of the Avaya SBCE, frame 11 is highlighted and expanded to show OPTIONS sent from Verizon IP C trunk (172.30.209.21) to the SBC (2.2.2.2). Observe the use of UDP for transport, from source port 5071 (Verizon) to destination port 5060 (Avaya). Verizon sends the IP address “2.2.2.2” in the Request-Line. Note that Max-Forwards is 70.

Before the Avaya SBCE replies to Verizon, the SBC sends OPTIONS to IP Office on the inside interface. In the trace shown below, taken from the inside interface of the SBC, frame 587 is highlighted and expanded to show OPTIONS sent from the inside interface of the SBC (10.64.19.199) to IP Office (10.80.150.70). Note that Max-Forwards header has been decremented by 1 and is now 69.
In this same trace, highlighted frame 590 below shows IP Office responding to the OPTIONS with 200 OK.

<table>
<thead>
<tr>
<th>No.</th>
<th>Time</th>
<th>Source</th>
<th>Destination</th>
<th>Protocol</th>
<th>Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>590</td>
<td>10:48:13.07</td>
<td>160.20.8.26</td>
<td>10.80.150.70</td>
<td>SIP</td>
<td>Request: OPTIONS sip:10.80.150.70</td>
</tr>
<tr>
<td>590</td>
<td>10:48:13.07</td>
<td>160.20.8.26</td>
<td>10.80.150.70</td>
<td>SIP/SIP</td>
<td>Status: 200 OK, with session description</td>
</tr>
</tbody>
</table>

Frame 590: 842 bytes on wire (6736 bits), 842 bytes captured (6736 bits)
- Ethernet II, Src: 00:50:56:b5:ac:31 (08:50::b5:ac:31), Dst: 00:50:56:b5:ac:31 (08:50::b5:ac:31)
- Internet Protocol, Src: 10.80.150.70 (10.80.150.70), Dst: 10.80.19.199 (10.80.19.199)
- Transmission Control Protocol, Src Port: sip (5060), Dst Port: 2048 (2048), Seq: 1, Ack: 107, Len: 786

Session Initiation Protocol
- Status-Line: SIP/2.0 200 OK
- Message-Header:
  - Via: SIP/2.0/UDP 10.80.150.70;branch=z9hG4bKusm7rmXGouyA0hpq2481
  - From: <sip:pplng671.20.30.209.21@sip:10.80.150.70;branch=z9hG4bKusm7rmXGouyA0hpq2481@10.80.150.70|
  - Contact: <sip:pplng671.20.30.209.21@sip:10.80.150.70;branch=z9hG4bKusm7rmXGouyA0hpq2481@10.80.150.70|
  - Max-Forwards: 70
  - Allow: OPTIONS, ACK, CANCEL, OPTIONS, BYE, REFER, NOTIFY, INFO, UPDATE
  - Supported: timer
  - Server: IP Office 8.1 (65)
  - Content-Type: application/sdp
  - Content-Length: 256

Returning to the outside trace, and advancing to frame 12, the 200 OK sent back to the inbound OPTIONS from Verizon is illustrated below. The receipt of a valid OPTIONS response from the CPE is necessary for Verizon to route inbound calls to the CPE. Since the SBC proxies the OPTIONS received from Verizon to IP Office, the end to end path from Verizon through to IP Office must be in service for OPTIONS (and ultimately calls) to be successful.

<table>
<thead>
<tr>
<th>No.</th>
<th>Time</th>
<th>Source</th>
<th>Destination</th>
<th>Protocol</th>
<th>Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>10:48:03.10</td>
<td>172.30.209.21</td>
<td>10.80.150.70</td>
<td>SIP</td>
<td>Request: OPTIONS sip:2.2.2.2:15060</td>
</tr>
<tr>
<td>12</td>
<td>10:48:03.10</td>
<td>172.30.209.21</td>
<td>10.80.150.70</td>
<td>SIP/SIP</td>
<td>Status: 200 OK, with session description</td>
</tr>
</tbody>
</table>

Frame 12: 842 bytes on wire (6704 bits), 842 bytes captured (6704 bits)
- Ethernet II, Src: 00:50:56:b5:ac:31 (08:50::b5:ac:31), Dst: 00:50:56:b5:ac:31 (08:50::b5:ac:31)
- User Datagram Protocol, Src Port: sip (5000), Dst Port: powerschool (1071)

Session Initiation Protocol
- Status-Line: SIP/2.0 200 OK
- Message-Header:
  - Via: SIP/2.0/UDP 172.30.209.21;branch=z9hG4bKusm7rmXGouyA0hpq2481
  - From: <sip:pplng671.20.30.209.21@sip:10.80.150.70;branch=z9hG4bKusm7rmXGouyA0hpq2481@10.80.150.70|
  - Contact: <sip:pplng671.20.30.209.21@sip:10.80.150.70;branch=z9hG4bKusm7rmXGouyA0hpq2481@10.80.150.70|
  - Max-Forwards: 70
  - Allow: OPTIONS, ACK, CANCEL, OPTIONS, BYE, REFER, NOTIFY, INFO, UPDATE
  - Supported: timer
  - Server: IP Office 8.1 (65)
  - Content-Type: application/sdp
  - Content-Length: 256

8.2. DNS SRV Testing
The Avaya SBCE capability to determine the Verizon SIP signaling address and port using DNS procedures was tested using the production Verizon PIP circuit. Rather than statically configure the SBC with Verizon’s IP Address and SIP signaling port, the SBC determined the Verizon IP Address and signaling port dynamically using DNS. On the production circuit used for testing,
Verizon responded with one “answer”. To test failover capabilities of the Avaya SBCE, an internal DNS was configured to respond with a fake IP address with a high priority and the real IP address with a lower priority. This illustrated how Avaya SBCE will use SIP OPTIONS messages to determine the state of each server and failover to the secondary server when the first server does not respond to OPTIONS. For simplicity, the following subsections will show the DNS SRV server respond with one “answer”.

### 8.2.1. Wireshark Trace Illustration for DNS SRV

This section illustrates the DNS signaling used when the Route Policy in Avaya SBCE is configured to use DNS SRV. Please reference Section 6.2 of these Application Notes for the relevant configuration. In the filtered Wireshark trace shown below, Frame 14 is highlighted and expanded. Avaya SBCE (10.64.19.100) sends a DNS SRV query to the internal DNS server (10.80.150.201) to correctly identify the SIP communication address (IP Address and Port) of the SIP server. Note that the query contains “_sip._udp.pcelban0001.avayalincroft.globalipcom.com” because the Next Hop Server of the Routing Policy was set to “pcelban0001.avayalincroft.globalipcom.com” and the Outgoing Transport was configured for UDP.

The DNS response in frame 15 is highlighted and expanded in the following screen. Note that the “Answer” contains Target “pc-n0001-elba.avayalincroft.globalipcom.com” and port 5071.
Frame 17 is expanded below to illustrate the Avaya SBCE DNS A-query to determine the IP Address associated with the name “pc-n0001-elba.avayalincroft.globalipcom.com” (i.e., the “Target” returned by Verizon as shown in the prior screen).

<table>
<thead>
<tr>
<th>Frame 17</th>
<th>103 bytes on wire (824 bits), 103 bytes captured (824 bits)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internet Protocol, Src: 10.64.19.199 (106419199), Dst: 10.80.150.201 (1080150201)</td>
<td></td>
</tr>
<tr>
<td>User datagram protocol, src port: domain (DNS), dst port: domain (DNS)</td>
<td></td>
</tr>
<tr>
<td>Domain name system (query)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Response to: 18</td>
</tr>
<tr>
<td>Transaction ID: 0x4496</td>
<td></td>
</tr>
<tr>
<td>Flags: 0x0100 (Standard query)</td>
<td></td>
</tr>
<tr>
<td>Questions: 1</td>
<td></td>
</tr>
<tr>
<td>Answer RRs: 0</td>
<td></td>
</tr>
<tr>
<td>Authority RRs: 0</td>
<td></td>
</tr>
<tr>
<td>Additional RRs: 0</td>
<td></td>
</tr>
<tr>
<td>Queries</td>
<td></td>
</tr>
<tr>
<td>- _sip._udp.pcoeblan0001.avayalincroft.globalipcom.com: type SRV, class IN</td>
<td></td>
</tr>
<tr>
<td>Answers</td>
<td></td>
</tr>
<tr>
<td>- _sip._udp.pcoeblan0001.avayalincroft.globalipcom.com: type SRV, class IN, priority 100, weight 50, port 5071, target pc-n0001-elba.avayalincroft.globalipcom.com</td>
<td></td>
</tr>
<tr>
<td>Types: SRV (Service纪录)</td>
<td></td>
</tr>
</tbody>
</table>
| Class: IN (IN)
| Time to live: 1 hour |
| Data length: 31 |
| Priority: 100 |
| Weight: 50 |
| Port: 5071 |
| Target: pc-n0001-elba.avayalincroft.globalipcom.com |

Frame 18 is expanded below to illustrate the Verizon “answer” to the Avaya SBCE DNS A-query. Note that the IP address returned is 172.30.209.21. The SBC has now determined the IP Address (172.30.209.21) and SIP signaling port (5071) used by Verizon IP Trunk service on the production circuit.
8.3. Avaya SBCE

This section provides verification steps that may be performed with the Avaya SBCE.

8.3.1. Incidents

The Incident Viewer can be accessed from the Avaya SBCE Dashboard as highlighted in the screen shot below.

Use the Incident Viewer to verify Server Heartbeat and to troubleshoot routing failures.
8.3.2. Tracing
To take a call trace, navigate to **Device Specific Settings → Trace** and select the **Packet Capture** tab. Populate the fields for the capture parameters and click **Start Capture** as shown below.

![Session Border Controller for Enterprise](image)

When tracing has reached the desired number of packets the trace will stop automatically, or alternatively, hit the **Stop Capture** button at the bottom.
### Trace: Micro SBC

#### Packet Capture Configuration

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>In Progress</td>
</tr>
<tr>
<td>Interface</td>
<td>U1</td>
</tr>
<tr>
<td>Local Address</td>
<td>123.45.67.89</td>
</tr>
<tr>
<td>Remote Address</td>
<td>?</td>
</tr>
<tr>
<td>Protocol</td>
<td>UDP</td>
</tr>
<tr>
<td>Maximum Number of Packets to Capture</td>
<td>1000</td>
</tr>
<tr>
<td>Capture Filename</td>
<td>T0507_DSCP_media.pcap</td>
</tr>
</tbody>
</table>

**Stop Capture**
Select the **Captures** tab to view the files created during the packet capture.

The packet capture file can be downloaded and then viewed using a Network Protocol Analyzer like WireShark.
8.4. IP Office
This section provides verification steps that may be performed with the IP Office.

8.4.1. System Status
The System Status application is used to monitor and troubleshoot IP Office. Use the System Status application to verify the state of the SIP trunk. System Status can be accessed from Start → Programs → IP Office → System Status. Or by opening an Internet browser and type the URL: http://ipaddress where ipaddress is the IP address of the Avaya IP Office LAN1 interface. Click on System Status to launch the application.

The following screen shows an example Logon screen. Enter the IP Office IP address in the Control Unit IP Address field, and enter an appropriate User Name and Password. Click Logon.
Select the SIP line under **Trunks** from the left pane. On the **Status** tab in the right pane, verify the **Current State** is **Idle** for each channel.

Select the **Alarms** tab and verify that no alarms are active on the SIP line.
8.4.2. Monitor

The Monitor application can also be used to monitor and troubleshoot IP Office. Monitor can be accessed from Start → Programs → IP Office → Monitor. The application allows the monitored information to be customized. To customize, select the button that is third from the right in the screen below, or select Filters → Trace Options.

The following screen shows the SIP tab, allowing configuration of SIP monitoring. In this example, the SIP Rx and SIP Tx boxes are checked. All SIP messages will appear in the trace with the color blue. To customize the color, right-click on SIP Rx or SIP Tx and select the desired color.
As an example, the following shows a portion of the monitoring window for an outbound call from extension 233, whose DID is 732-945-0233, calling out to the PSTN via the Verizon Business IP Trunk service. The telephone user dialed 9-1-303-538-7024.

9. Conclusion

IP Office is a highly modular IP telephone system designed to meet the needs of home offices, standalone businesses, and networked branch and head offices for small and medium enterprises. These Application Notes demonstrated how IP Office Release 8.1 and Avaya Session Border Controller for Enterprise can be successfully combined with a Verizon Business IP Trunk SIP trunk service connection to create an end-to-end SIP Telephony business solution. By following the example configurations provided in this document, customers using Avaya IP Office and Avaya SBCE can connect to the PSTN via a Verizon Business IP Trunk SIP Trunk service connection, thus eliminating the costs of analog or digital trunk connections previously required to access the PSTN. Utilizing this solution, IP Office customers can leverage the operational efficiencies and cost savings associated with SIP trunking while gaining the advanced technical features provided through the marriage of best of breed technologies from Avaya and Verizon.

Compliance testing was successful. Any limitations related to the overall configuration are noted in Section 2.2
10. References


Product documentation for Avaya products may be found at http://support.avaya.com.
11. Appendix A: SIP Line Template

Avaya IP Office Release 8.1 supports a SIP Line Template (in xml format) that can be created from an existing configuration and imported into a new installation to simplify configuration procedures as well as to reduce potential configuration errors.

Note that not all of the configuration information, particularly items relevant to a specific installation environment, is included in the SIP Line Template. Therefore, it is critical that the SIP Line configuration be verified/updated after a template has been imported and additional configuration be supplemented using Section 5.4 in these Application Notes as a reference.

The SIP Line Template created from the configuration as documented in these Application Notes is as follows:

```xml
<?xml version="1.0" encoding="utf-8"?>
<Template xmlns="urn:SIPTrunk-schema">
  <TemplateType>SIPTrunk</TemplateType>
  <Version>20130219</Version>
  <SystemLocale>enu</SystemLocale>
  <DescriptiveName>Avaya SBCE</DescriptiveName>
  <ITSPDomainName>10.64.19.199</ITSPDomainName>
  <SendCallerID>CallerIDDIV</SendCallerID>
  <ReferSupport>true</ReferSupport>
  <ReferSupportIncoming>1</ReferSupportIncoming>
  <ReferSupportOutgoing>1</ReferSupportOutgoing>
  <RegistrationRequired>false</RegistrationRequired>
  <UseTelURI>false</UseTelURI>
  <CheckOOS>true</CheckOOS>
  <CallRoutingMethod>1</CallRoutingMethod>
  <OriginatorNumber />
  <AssociationMethod>SourceIP</AssociationMethod>
  <LineNamePriority>SystemDefault</LineNamePriority>
  <UpdateSupport>UpdateAuto</UpdateSupport>
  <UserAgentServerHeader />
  <CallerIDfromFromheader>false</CallerIDfromFromheader>
  <PerformUserLevelPrivacy>false</PerformUserLevelPrivacy>
  <ITSPProxy>10.64.19.199</ITSPProxy>
  <LayerFourProtocol>SipTCP</LayerFourProtocol>
  <SendPort>5060</SendPort>
  <ListenPort>5060</ListenPort>
  <DNSServerOne>0.0.0.0</DNSServerOne>
  <DNSServerTwo>0.0.0.0</DNSServerTwo>
  <CallsRouteViaRegistrar>true</CallsRouteViaRegistrar>
  <SeparateRegistrar />
  <CompressionMode>AUTOSELECT</CompressionMode>
  <UseAdvVoiceCodecPrefs>true</UseAdvVoiceCodecPrefs>
  <AdvCodecPref>G.722 64K,G.729(a) 8K CS-ACELP,G.711 ULAW 64K</AdvCodecPref>
  <CallInitiationTimeout>4</CallInitiationTimeout>
  <DTMFSupport>DTMF_SUPPORT_RFC2833</DTMFSupport>
  <VoipSilenceSupression>false</VoipSilenceSupression>
</Template>
```
<ReinviteSupported>true</ReinviteSupported>
<FaxTransportSupport>FOIP_T38FB</FaxTransportSupport>
<UseOffererPreferenceCodec>false</UseOffererPreferenceCodec>
<CodecLockdown>false</CodecLockdown>
<Rel100Supported>false</Rel100Supported>
<T38FaxVersion>3</T38FaxVersion>
<Transport>UDPTL</Transport>
<LowSpeed>0</LowSpeed>
<HighSpeed>0</HighSpeed>
<TCFMethod>Trans_TCF</TCFMethod>
<MaxBitRate>FaxRate_14400</MaxBitRate>
<EflagStartTimer>2600</EflagStartTimer>
<EflagStopTimer>2300</EflagStopTimer>
<UseDefaultValues>false</UseDefaultValues>
<ScanLineFixup>true</ScanLineFixup>
<TFOPEncapsulation>true</TFOPEncapsulation>
<DisableT30ECM>true</DisableT30ECM>
<DisableEflagsForFirstDIS>false</DisableEflagsForFirstDIS>
<DisableT30MRCompression>false</DisableT30MRCompression>
<NSFOverride>false</NSFOverride>

To import the above template into a new installation:

1. On the PC where IP Office Manager was installed, copy and paste the above template into a text document named **US_AvayaSBCE-Verizon_SIPTrunk.xml**. Move the .xml file to the IP Office Manager template directory (C:\Program Files\Avaya\IP Office\Manager\Templates). It may be necessary to create this directory.

2. Import the template into an IP Office installation by creating a new SIP Line as shown in the screenshot below. In the Navigation Pane on the left, right-click on **Line** then navigate to **New → New SIP Trunk From Template**: 

1. Verify that “United States” is automatically populated for **Country** and “AvayaSBCE-Verizon” is automatically populated for **Service Provider** in the resulting Template Type Selection screen as shown below. Click **Create new SIP Trunk** to finish the importing process.
©2013 Avaya Inc. All Rights Reserved.
Avaya and the Avaya Logo are trademarks of Avaya Inc. All trademarks identified by ® and ™ are registered trademarks or trademarks, respectively, of Avaya Inc. All other trademarks are the property of their respective owners. The information provided in these Application Notes is subject to change without notice. The configurations, technical data, and recommendations provided in these Application Notes are believed to be accurate and dependable, but are presented without express or implied warranty. Users are responsible for their application of any products specified in these Application Notes.

Please e-mail any questions or comments pertaining to these Application Notes along with the full title name and filename, located in the lower right corner, directly to the Avaya DevConnect Program at devconnect@avaya.com.